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DISCLAIMER AND LIMITATIONS ON WARRANTIES. NEXANT DOES NOT WARRANT 
THAT THE PROGRAM PROVIDED IS FREE FROM CODING ERRORS OR OTHER 
DEFECTS.  USER’S USE OF THE PROGRAM IS AT THE USER’S SOLE RISK.  THE 
PROGRAM SOFTWARE AND ASSOCIATED DOCUMENTATION MAY CONTAIN 
DEFECTS, FAIL TO COMPLY WITH APPLICATION SPECIFICATION, AND MAY 
PRODUCE UNINTENDED OR ERRONEOUS RESULTS WHEN OPERATED BY ITSELF OR 
IN COMBINATION WITH OTHER HARDWARE OR SOFTWARE PRODUCTS.  THE 
PROGRAM IS PROVIDED “AS IS”.  THE USER ACCEPTS THE PROGRAM PROVIDED BY 
NEXANT “AS IS” AND ASSUMES ALL RISKS ASSOCIATED WITH ITS USE, QUALITY, 
AND PERFORMANCE.  TO THE EXTENT PERMITTED BY LAW, NEXANT EXPRESSLY 
DISCLAIMS ANY AND ALL WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR 
A PARTICULAR PURPOSE AND ALL WARRANTIES AS TO THE ACCURACY, 
COMPLETENESS AND NON-INFRINGEMENT OF THE PROGRAM, USED EITHER 
ALONE OR WITH THIRD PARTY SOFTWARE. 
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Section 1  Introduction 

This document provides an overview of the installation, start-up, and operation of the financial 
model developed by Nexant, Inc. as part of the Integrated Gasification Combined Cycle (IGCC) 
Economic and Capital Budgeting Practices program for NETL.   The financial model calculates 
investment decision criteria used by industrial end-users and project developers to evaluate the 
economic feasibility of power systems, including (but not limited to) integrated gasification 
combined cycle (IGCC), natural gas combined cycle, and coal systems.  By conducting analysis 
with the financial model, the DOE will be able to evaluate different power systems applications 
on a uniform basis.    

Important: Before proceeding, please refer to Appendix C: System Requirements. 

The Power Systems Financial Model Version 5.0 (references are also made in this manual to 
previous versions of the model, the IGCC Financial Model Versions 3.0 and 4.0) consists of 22 
spreadsheets that were created in Microsoft Excel 2003 workbook format, with interfaces and 
supporting code developed in Visual Basic.   The spreadsheets in the model are organized into 
four main sections: data input sheets, supporting analysis sheets, financial statements, and project 
summary result sheets.  Figure 1-1, shown below, outlines the main sections of the model and 
illustrates the process by which the model uses input data to perform the calculations required to 
develop financial statements and summary results for power projects.   Table 1-1 describes each 
of the spreadsheets in the model. 

Data Input Sheets Supporting Analysis
• Construction schedule
• Interest during construction
• Depreciation
• Escalation
• Financing
• Expenses
• Revenues
• Working capital

Financial Statements
• Income statement
• Cash flow
• Balance sheet
• Sources and uses

Project Summary Results
• Project overview
• Financial 
• Cost summary
• Plant performance

• Plant Input 
• Scenario Input
• Forecast Fuel Prices

• EPC Escalation

Data Input Sheets Supporting Analysis
• Construction schedule
• Interest during construction
• Depreciation
• Escalation
• Financing
• Expenses
• Revenues
• Working capital

Financial Statements
• Income statement
• Cash flow
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• Financial 
• Cost summary
• Plant performance

• Plant Input 
• Scenario Input
• Forecast Fuel Prices
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• Cost of Electricity Calculation

Data Input Sheets Supporting Analysis
• Construction schedule
• Interest during construction
• Depreciation
• Escalation
• Financing
• Expenses
• Revenues
• Working capital

Financial Statements
• Income statement
• Cash flow
• Balance sheet
• Sources and uses

Project Summary Results
• Project overview
• Financial 
• Cost summary
• Plant performance

• Plant Input 
• Scenario Input
• Forecast Fuel Prices

• Plant Input 
• Scenario Input
• Plant Input 
• Scenario Input
• Forecast Fuel Prices• Forecast Fuel Prices

• EPC Escalation• EPC Escalation

Data Input Sheets
Supporting Analysis

Construction schedule
Interest during construction
Depreciation
Escalation
Financing
Expenses
Revenues
Working capital

Financial Statements
Income statement
Cash flow
Balance sheet
Sources and uses

Project Summary Results
Project overview
Financial Results 
Cost summary
Plant performance

Plant Input 
Scenario Input
Plant Input 
Scenario Input
Forecast Fuel PricesForecast Fuel Prices

Plant Input 
Scenario Input
Plant Input 
Scenario Input
Forecast Fuel PricesForecast Fuel Prices

EPC Escalation
Cost of Electricity Calculation
O&M Calculation

Data Input Sheets Supporting Analysis
• Construction schedule
• Interest during construction
• Depreciation
• Escalation
• Financing
• Expenses
• Revenues
• Working capital

Financial Statements
• Income statement
• Cash flow
• Balance sheet
• Sources and uses

Project Summary Results
• Project overview
• Financial 
• Cost summary
• Plant performance

• Plant Input 
• Scenario Input
• Forecast Fuel Prices

• Plant Input 
• Scenario Input
• Plant Input 
• Scenario Input
• Forecast Fuel Prices• Forecast Fuel Prices

• EPC Escalation• EPC Escalation

Data Input Sheets Supporting Analysis
• Construction schedule
• Interest during construction
• Depreciation
• Escalation
• Financing
• Expenses
• Revenues
• Working capital

Financial Statements
• Income statement
• Cash flow
• Balance sheet
• Sources and uses

Project Summary Results
• Project overview
• Financial 
• Cost summary
• Plant performance

• Plant Input 
• Scenario Input
• Plant Input 
• Scenario Input
• Forecast Fuel Prices• Forecast Fuel Prices

• Plant Input 
• Scenario Input
• Plant Input 
• Scenario Input
• Forecast Fuel Prices• Forecast Fuel Prices

• EPC Escalation• EPC Escalation
• Cost of Electricity Calculation

Data Input Sheets Supporting Analysis
• Construction schedule
• Interest during construction
• Depreciation
• Escalation
• Financing
• Expenses
• Revenues
• Working capital

Financial Statements
• Income statement
• Cash flow
• Balance sheet
• Sources and uses

Project Summary Results
• Project overview
• Financial 
• Cost summary
• Plant performance

• Plant Input 
• Scenario Input
• Plant Input 
• Scenario Input
• Forecast Fuel Prices• Forecast Fuel Prices

• Plant Input 
• Scenario Input
• Plant Input 
• Scenario Input
• Forecast Fuel Prices• Forecast Fuel Prices

• EPC Escalation• EPC Escalation

Data Input Sheets
Supporting Analysis

Construction schedule
Interest during construction
Depreciation
Escalation
Financing
Expenses
Revenues
Working capital

Financial Statements
Income statement
Cash flow
Balance sheet
Sources and uses

Project Summary Results
Project overview
Financial Results 
Cost summary
Plant performance

Plant Input 
Scenario Input
Plant Input 
Scenario Input
Forecast Fuel PricesForecast Fuel Prices

Plant Input 
Scenario Input
Plant Input 
Scenario Input
Forecast Fuel PricesForecast Fuel Prices

EPC Escalation
Cost of Electricity Calculation
O&M Calculation

 
Figure 1-1  Organization of the Power Systems Financial Model 
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Table 1-1 PSFM Worksheets 

Worksheet Description 
Overview User selects the active scenario on this sheet, overview of results are displayed 

Results Key financial results are reported 

Plant Performance A summary of plant capacity, outputs, and performance.  No inputs on this page. 

Cost Summary Summary of capital costs, construction costs by year, and operating expenses 

Plant Inputs The input sheet for plant data.  Up to seven plant cases can be entered. 

Scenario Inputs The input sheet for financial, economic, fuels, products, tariff, and construction 
parameters.  The inputs are common for all plant scenarios defined in the Plant 
Inputs sheet.  

O&M Input sheet for Variable and Fixed O&M costs for each project.  O&M costs can be 
alternatively input as a percentage of EPC cost in the Plant Inputs sheet. 

COE Calculation Calculates the Levelized Cost of Electricity and the Capital Charge Factor for a 
given scenario 

Fuel Forecasts Input of yearly forecasts for the cost of fuel inputs.  The user can alternatively input 
a single escalation factor for each fuel in the Scenario Input Sheet. 

EPC Escalation Allows the user to escalate construction costs over the construction period 

Income Statement Calculation of Operating Income, Income Before Taxes, Taxable Income, and Net 
Income 

Balance Sheet A balance sheet of liabilities, assets, and shareholder’s equity 

Sources and Uses Accounting of fund sources (debt, equity, revenue) and uses (various expenses) 

Cash Flow Calculates Operating Cash Flow, Net Cash Flow, and Net Cash Available for 
Equity Distribution, upon which the IRR calculation is based.  IRR is thus a 
measure of available Return on Equity. 

Revenues Accounting of all project revenues 

Expenses Accounting of all project expenses 

Financing Accounting of debt financing and repayment 

Interest During Construction  Calculates the interest expenses incurred during the construction period 

Depreciation Accounts for the depreciation of construction and financing charges.  Either the 
Straight-Line (“SL”) or the Declining Balance (“DB”) methods are selected in the 
Scenario Inputs sheet 

Working Capital Accounts for the initial working capital and changes in working capital 

Construction Schedule Accounts for the allocation of funds during construction.  The allocation of Total 
Required Capital is specified by percentage per construction year in the Scenario 
Input sheet. 

Escalation Set of escalation factors for each input and product by year.  Typically inputted as 
nominal values, since model dollars usually in nominal terms. 
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1.1 DISCOUNTED CASH FLOW AND INTERNAL RATE OF RETURN 
The PSF Model conducts a Discounted Cash Flow analysis of power systems.  The model was 
conceived and designed primarily to evaluate Independent Power Projects (IPPs), rather than 
regulated utility projects.  The primary financial metric in DCF analysis is the Internal Rate of 
Return (IRR).  DCF differs from the regulated utility Revenue Requirements (RR) methodology 
(as specified in the EPRI TAGTM), in that the Return on Equity in the DCF is calculated and 
reported as the IRR, rather than specified as an input, as in the RR.  The RR method calculates 
the Cost of Electricity (COE), whereas in DCF, COE is provided as an input. 

Version 5.0 of the model calculates the COE, and calculates the associated Capital Charge 
Factor.  See Section 2.7 for instructions for using the COE calculation. 

1.2 THE PSFM MODEL AND THE EPRI TAGTM 
The EPRI TAGTM Revenue Requirements methodology for computing the levelized cost of 
electricity has historically been the dominant method of financial analysis of power projects.  
The methodology was developed for, and is most relevant to, regulated investor-owned utility 
power project development.  DCF analysis that calculates an IRR is most relevant for 
independent power projects that will operate in competitive markets. 

The RR and DCF methodologies differ in one important respect.  Under RR, given the required 
Return on Equity (ROE), Cost of Debt (COD), depreciation, and O&M expenses, the 
methodology computes the necessary COE to support the capital investment and operating 
expenses of the plant.  The COE is then often levelized over a period of 10, 20, or 30 years.   
Under a DCF analysis, given the COE, the COD, and depreciation and O&M expenses, the 
methodology computes the ROE as the Internal Rate of Return (IRR) as the investment decision 
criteria for equity investors. 

The RR method charges each year of the book life (book life =x) with a “book depreciation” 
charge equal to 1/x of the original investment (debt and equity portions,) charges corresponding 
to the debt and equity return required on the non-“book”-depreciated portion of the original 
investment, as well as operating expenses over the book life. (“Tax” depreciation could be done 
over a different period.)  This leads to a series of declining values to pay back the investment, 
with the associated required returns. These values are used to calculate the yearly Cost of 
Electricity to support the required returns on investment.  The COE is then levelized over a 10, 
20 or 30 year period. 

By contrast in DCF, the debt portion of the project is a constant payment comprised of interest 
and principle.  As the loan is paid, the interest portion declines, and the principle portion 
increases, exactly as is the case in the repayment of a home mortgage.  The DCF method 
computes the series of cash flows for the given cost of debt, revenues, and other costs.  The IRR 
of the net positive cash flows over the life of the project is calculated.  This IRR can also be 
thought of as the Return on Equity available to return to the equity investors. 
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1.3 CONSTANT (REAL) AND CURRENT (NOMINAL) DOLLAR BASIS 
The PSFM allows users to escalate economic parameters.  The escalation rates include both the 
effects of monetary inflation and real price escalation when entered in nominal terms (typically 
used).   There is no separate parameter for inflation in the model. 

The PSFM is designed to deal with cash flows on a Current, or Nominal basis.  That is to say, 
the dollars in any year represent the actual dollar figure in that year.  The escalation rates for 
prices should thus include both the inflation rate and the escalation rates for individual 
commodity prices.  Nominal dollars are the preferred basis for discounted cash flow analysis that 
includes the affects of taxes and depreciation, because depreciation is not affected by inflation. 

The IRR computed by the PSFM includes the general inflation rate embedded in the escalation 
rates.  The computed COE also is based on current dollars. 

1.4 TIME SENSITIVE MODEL PARAMETERS 
The PSFM contains a number of default input parameters in the Scenario Inputs and Plant Inputs 
sheets.  As is emphasized throughout this manual, the user should independently verify all 
parameters used in the analysis.  The user should also refer to the Quality Guidelines for Energy 
Systems Studies from NETL for a list of currently valid default parameters. 

Table 1-2 contains a list of parameters that should be independently verified and periodically 
updated by the user in the PSFM. 
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Table 1-2 Required Validation of Time Sensitive Default Parameters  

Parameter Input Sheet Description 

Variable and Fixed O&M cost as a 
% of EPC 

Plant Inputs Variable is currently  set to 1.5% of EPC 
cost; Fixed is set to 3.5% of EPC cost 

Variable and Fixed O&M cost 
entered in base year dollars 

O&M If this option is used, the O&M costs 
entered in the O&M sheet should be 
verified to be in the base year of the 
analysis 

Debt/Equity Ratio Scenario Inputs Currently set to 70%/30% 

Debt Reserve Fund Scenario Inputs If this option is used, the default reserve 
fund interest rate default is 5%, and the 
percentage of total debt service used as 
DRF is 50% 

Working Capital Scenario Inputs If working capital is used, the days 
receivable and payable are set to 30 
days; annual operating cash is set to 
$50,000, and the initial working capital is 
set to 7% of first years revenues.  
Otherwise, these parameters are set to  
zero. 

Allocation of EPC and financing 
costs over the construction period 

Scenario Inputs The user should verify that the default 
allocations reasonably correspond to the 
planned project funds outlay during 
construction, or, equally allocate the 
funds over the construction period 

Fuel Price Forecasts Fuel Forecasts If forecast fuel prices, rather than 
constant escalated prices, are used, the 
forecast prices in the Fuel Forecast 
sheet should be verified.  Costs should 
stated be in nominal dollars. 

 

1.5 ORGANIZATION OF THIS MANUAL 
The remainder of this users’ guide to the PSF Model contains the following sections: 

 Operation of the financial model 

 Key Definitions and Assumptions  



Section 1  Introduction 

 Power Systems Financial Model Version 5.0 Users’ Guide 6 

 Guide to data input in the Plant Inputs and Scenario Inputs sheets  

 A glossary for all key model parameters and inputs 

 An instructions sheet on model installation and start-up procedures  

 A version history of the PSFM  
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Section 2  Operation of the PSFM 

2.1 BASIC OPERATING STEPS 
Upon opening the model, the user will be automatically directed to the project Overview Sheet.  
Once the model is fully opened, the user should follow the three-step procedure illustrated below 
in Figure 2-1 to conduct financial analysis of a power project. 

Step 2
Enter scenario specific data into the Scenario Input Sheet
• Financial and economic data
• Fuel data
• Tariff assumptions
• Construction schedule data

Model Results
The model will generate the following key results:
• Project summary report
• Financial statements
• Supporting analysis sheets

Step 1
Enter IGCC plant data into the Plant Input Sheet
• Project summary
• Plant output and operating data
• Capital costs
• Operating costs and expenses

Step 3
Select IGCC plant case on the Overview Sheet and click on the “r efresh” button

• Scenario Options
- Debt Reserve Fund
- Depreciation Technique
- Forecast Fuel Prices
- EPC Escalation

Step 2
Enter scenario specific data into the Scenario Input sheet
• Financial and economic data
• Fuel data
• Tariff assumptions
• Construction schedule data

• Financial and economic data
• Fuel data
• Tariff assumptions
• Construction schedule data

Model Results
The model will generate the following key results:
• Project summary report
• Financial statements
• Supporting analysis sheets

Step 1
Enter plant data into the Plant Input sheet
• Project summary
• Plant output and operating data
• Capital costs
• Operating costs and expenses

Step 3
Select plant case on the Overview Sheet and click on the “Recalculate” button

• Scenario Options
- Debt Reserve Fund
- Depreciation Technique
- Forecast Fuel Prices
- EPC Escalation

• Scenario Options
- Debt Reserve Fund
- Depreciation Technique
- Forecast Fuel Prices
- EPC Escalation

Additional Analysis
Compute the Levelized Cost of 
Electricity and the Equivalent 
Capital Charge Factor

Step 2
Enter scenario specific data into the Scenario Input Sheet
• Financial and economic data
• Fuel data
• Tariff assumptions
• Construction schedule data

• Financial and economic data
• Fuel data
• Tariff assumptions
• Construction schedule data

Model Results
The model will generate the following key results:
• Project summary report
• Financial statements
• Supporting analysis sheets

Step 1
Enter IGCC plant data into the Plant Input Sheet
• Project summary
• Plant output and operating data
• Capital costs
• Operating costs and expenses

Step 3
Select IGCC plant case on the Overview Sheet and click on the “r efresh” button

• Scenario Options
- Debt Reserve Fund
- Depreciation Technique
- Forecast Fuel Prices
- EPC Escalation

• Scenario Options
- Debt Reserve Fund
- Depreciation Technique
- Forecast Fuel Prices
- EPC Escalation

Step 2
Enter scenario specific data into the Scenario Input sheet
• Financial and economic data
• Fuel data
• Tariff assumptions
• Construction schedule data

• Financial and economic data
• Fuel data
• Tariff assumptions
• Construction schedule data

Model Results
The model will generate the following key results:
• Project summary report
• Financial statements
• Supporting analysis sheets

Step 1
Enter plant data into the Plant Input sheet
• Project summary
• Plant output and operating data
• Capital costs
• Operating costs and expenses

Step 3
Select plant case on the Overview Sheet and click on the “Recalculate” button

• Scenario Options
- Debt Reserve Fund
- Depreciation Technique
- Forecast Fuel Prices
- EPC Escalation

• Scenario Options
- Debt Reserve Fund
- Depreciation Technique
- Forecast Fuel Prices
- EPC Escalation

Additional Analysis
Compute the Levelized Cost of 
Electricity and the Equivalent 
Capital Charge Factor

Additional Analysis
Compute the Levelized Cost of 
Electricity and the Equivalent 
Capital Charge Factor  

Figure 2-1  Operating Steps for the Financial Model 
Step 1. Using the Directory (located on the menu bar), go to the Model Inputs menu option and 
select the Plant Inputs sheet.  The Plant Inputs sheet is the primary repository of project 
summary, plant outputs, capital costs, and operating expense data.  To successfully operate the 
model, all required plant data should be entered into the relevant project cases.  The Plant Inputs 
sheet is capable of storing data for up to seven plants (Cases A to G).  See Appendix A for a 
detailed documentation and description of the Plant Inputs sheet.    

Step 2. Using the Directory, go to the Model Inputs menu option and select the Scenario Inputs 
sheet.  The Scenario Inputs sheet is the repository for key financial, economic, pricing, and 
construction schedule data.  Some data is specific to each plant (such as construction start date 
and construction duration), but most other data is general to all plant configurations (such as 
escalation factors, depreciation technique, and plant life.)    Prior to conducting analysis, all 
scenario specific data should be entered and/or reviewed by the user of the model.  In particular, 
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the user of the model should ensure that the data contained in the plant construction section and 
project debt terms is still valid.   

Important  It is important to note that sheets contain both input and calculation cells.  Input cells 
are designated by a blue color code and calculation (formula) cells are designated by a red color 
code.  The user must avoid entering any data in cells that are colored red (see troubleshooting 
section).  See Appendix A for detailed documentation and description of the Scenario Inputs 
sheet. 

Important The data in the Scenario Inputs sheet applies to all plant configurations input into the 
Plant Inputs sheet.  This is so that alternative plant configurations can be compared on an 
equivalent basis.  If the user wants to compare the same set of plant configurations based upon 
different scenario data, a copy of the spreadsheet should be made and the Scenario Inputs data 
should be changed. 

Important The user should not rely upon any of the default values in the Scenario Inputs sheet 
(such as yearly EPC cost allocations or fuel, EPC, or tariff escalation.)  All data should be 
independently developed and verified.  Acceptable default values for financial analysis can be 
found in the Quality Guidelines for Energy Systems Studies from NETL. 

Step 3. Using the Directory, return to the Overview sheet.  Using the drop-down box located in 
the upper left-hand corner of the Overview sheet, select a plant case to be evaluated (the names 
of projects entered in the Plant Inputs sheet will be displayed in this drop-down box).  As a final 
step after selecting a case, click-on the “Recalculate” button (also located in the upper left-hand 
corner of the sheet) to ensure that any recently entered data is incorporated into the final analysis.   

Very Important Each time data is entered or changed in the Scenario Inputs sheet, the user must 
go to the Overview sheet and click “Recalculate” to ensure that the new scenario data is loaded. 

2.2 RUNNING SCENARIOS 
Up to seven different plant profiles can be maintained in the Plant Inputs sheet.  However, only 
one scenario profile can be stored in the Scenario Inputs sheet.  Each time a new Scenario is run, 
it is important that the user review the Scenario Inputs sheet to ensure that the input data is still 
relevant to the new scenario.  Results for a specific plant case are generated each time the user 
selects a case from the drop-down box (located in the Overview sheet) and clicks on the 
“Recalculate” button.   The model is designed such that that specific plant designs and cases are 
compared on an equivalent basis using the same scenario profile. 

There are several key input selections on the Scenario Inputs worksheet that should be noted.  
The user must specify if each of these options is in effect in the current scenario with a “yes/no” 
or selected choice in the Scenario Input sheet.  See also Appendices A and B for further 
information. 

 Debt Reserve Fund (Line 38): Yes/No to include a debt reserve fund in the scenario  
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 Plant Ramp-up (Line 136): Yes/No to active a plant ramp-up, in which the plant phases 
in capacity over two years, quarter by quarter   

 Depreciation Technique (Lines 42-43): Choice of straight-line or 150% declining 
balance (15 or 20 years) depreciation techniques.  The user enters “SL” (straight-line) or 
“DB” (150% declining balance, 15 or 20 years.) 

 EPC Cost Escalation (Line 121): Yes/No to escalate EPC costs over the construction 
period 

 Forecast or Escalated Fuel Prices (Line 94): Yes/No option to use forecasted vs. 
escalated prices.  Fuel price can be escalated from a base by a constant escalation factor, 
or forecast prices (from EIA, for example) can be used 

 Investment Tax Credit (Lines 85-86): Yes/No option to include the Investment Tax 
Credit.  The ITC is applied to the EPC cost, and credited in the first year of start-up.  A 
maximum allowable ITC can be specified.  The ITC cannot be carried over into future 
years. 

Reminder The user should not rely upon any of the default values in the Scenario Inputs sheet 
(such as yearly EPC construction cost allocations or fuel, EPC, or tariff escalation factors.)  All 
data should be independently developed and verified. 

Important Reminder Any time that changes are made to any data input sheet, including the 
Scenario Inputs, the Plant Inputs, or the Fuel Forecast Prices sheets, the user must return to the 
Overview sheet and press the “Recalculate” button to obtain the current scenario results. 

2.3 MODEL DIRECTORY MENU 
The PSF Model has a drop-down Directory menu (see Figure 2-2 below) that allows the user to 
easily navigate the model’s twenty-two worksheets.  The user can also perform the same 
functions by using the tabs located at the bottom of each sheet.   
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Figure 2-2  PSFM Model Directory Menu Display 

2.4 LOCKED DATA 
The model has been set up so that the user is unable to edit, add, or delete any formula contained 
in the non-input sheets of the model.  With the exception of the input sheets (Plant Inputs and 
Scenario Inputs) and the COE Calculation sheet, all of the worksheets in the model are set-up as 
read-only.   

2.5 PRINTING OPTIONS 
The model has built-in print options that allow the user to print either certain subsets or all of the 
model’s worksheets.  To use this option, the user should go to File ⇒ Print Options… and select 
accordingly.  These ‘Print Options’ should be used while in the Overview sheet. 

A plant scenario description is included at the top of each printed page.  This description is 
entered in Line 48 of the Plant Inputs sheet for each plant profile. 

2.6 TROUBLESHOOTING 
Table 2-1 contains a list of solutions to potential problems that a user may encounter when 
operating the PSF Model.   
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Table 2-1  Power Systems Financial Model Troubleshooting Recommendations 
 

Problem Possible Solutions 
Results are missing, do 
not appear in the form of 
a number, or appear to 
be incorrect 

• Click the “Recalculate” button 
• Excel’s auto-calculation feature might be turned off.  Go to Tools ⇒ Options…  

Click on the Calculation tab.  Click on the Automatic box, then select OK 
• Check that data in the Scenario Inputs sheet are in accordance with the Plant 

selection that you have made 
• Check that all inputs are correctly entered.  For those inputs involving specific unit 

types, ensure that the unit amounts and types are correct 
• Check that the formula cells (shown in red) in the Scenario Inputs sheet have not 

been altered.  If the formulas have been altered, open the original (CD-ROM) 
version or a backup of the model and create a new file.  The user can then 
manually re-enter any relevant input data into the new version of the model. The 
user can prevent this problem by avoiding cells colored in red in the Scenario 
Inputs sheet  

Directory Menu and/or 
Print Option menus are 
missing 

• This is most likely due to the user selecting “Cancel” when asked to Save the 
model during the closing process.  To regain the menus, close the model (saved or 
unsaved) and then reopen the file 

Upon opening the model, 
a message appears 
saying: “filename.xls is 
already open.  
Reopening will cause any 
changes you made to be 
discarded.  Do you want 
to reopen filename.xls?” 

• Make sure that a version of the model with the same file name is not already open.  
When creating copies of the model in which to enter new data into the Scenario 
Inputs sheet, make sure copies of the model have different names corresponding 
to the alternative scenario under consideration. 

 
 
2.7 COST OF ELECTRICITY AND CAPITAL CHARGE FACTOR CALCULATION 
Version 5.0 of the Power Systems Financial Model has been enhanced to include the capability 
to calculate the Cost of Electricity (COE) and the equivalent Capital Charge Factor (CCF) under 
a Revenue Requirements (RR) methodology (as specified in the EPRI TAGTM) for the 
Discounted Cash Flow (DCF) analysis as carried out in the PSF Model.  This section explains 
the methodology and outlines the steps required to compute the levelized COE and CCF.  

The RR and DCF methodologies differ in one important respect.  Under RR, given the required 
Return on Equity (ROE), Cost of Debt (COD), depreciation, and O&M expenses, the 
methodology computes the necessary yearly COE to support the capital investment and operating 
expenses of the plant.  The COE is then often levelized over a period of 10, 20, or 30 years.    

Under DCF, given an initial COE (with nominal escalation), the COD, and the depreciation and 
O&M expenses, the methodology computes Internal Rate of Return (IRR), which is the ROE that 
is available to return to equity investors.  The IRR is used as an investment criteria as follows:  if 
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the IRR is greater than the minimum required ROE, the project is potentially an attractive 
investment option. 

Internal Rate of Return (IRR) refers generically to that rate of return corresponding to a specific 
cash flow that yields in a net present value (NPV) of zero.  In the PSFM, the project’s cash flow 
is determined by accounting for all costs and financial obligations and revenues for the project.  
The financial obligations include service on the project debt.  The remaining positive cash flows 
are available for return to equity investors.  Thus, in the PSFM, the IRR corresponds to the 
project’s Return on Equity. 

In order to compute the COE for a given DCF scenario, the following steps are executed in the 
COE Calculation sheet. 

STEP 1 

The user first inputs the plant and scenario data for the power systems under study.   Of 
particular importance are the definitions of Bare Erected Cost (BEC), Engineering Procurement 
and Construction Cost (EPC), Total Plant Cost (TPC) and Total Required Capital (TRC).   

BEC is the sum of all process equipment, supporting facilities, and direct and indirect labor.  
BEC is the most fundamental cost estimate and is used as the basis for calculating engineering 
and home office fees.   

EPC includes the BEC, plus detailed design and construction and project management.  EPC is 
the basis for calculating process and project contingencies, on a percentage basis of EPC.  The 
EPC cost should be entered consistent with the Base Year reflected on the Scenario Inputs tab. 

TPC includes EPC plus process and project contingencies, and technologies fees. 

Finally, the TRC is includes the TPC, plus startup costs, owners costs, financing costs, and the 
time value of money over the construction period, calculated as the Interest During Construction 
(IDC).  

In the Cost Summary sheet, TPC is the sum of EPC Costs, Owner’s (Project) Contingency, and 
Process Contingency.  These parameters are input in the Plant Inputs sheet.  The TRC includes 
all other capital items, including Start-up, Owner’s Cost, Financing Fees, and IDC 

The COE and levelized COE are computed on the basis of the TRC.  The levelized CCF is 
computed on the basis of the TPC, the O&M charges, and the levelized COE. 

 

STEP 2 

In the COE Calculation sheet, the user inputs the required Return on Equity and the Levelization 
Basis.  The levelization basis must be 10, 20, or 30 years.  Note here that the model assumes that 
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the equity must be returned within the levelization period but that the debt term is not changed to 
equal the levelization period. The COE Calculation sheet reports the other key input parameters, 
which are input in the Plant Inputs and Scenario Inputs sheets.  These include the Weighted Cost 
of Debt, COE Escalation, Tax Rate, Debt and Equity ratios, TEC and TRC. 

STEP 3 

The user inputs an initial guess of the electricity charge ($/kWh) for the first year that is 
escalated by a uniform rate.  This escalation rate is input on the Scenario Inputs sheet; typically, 
a nominal escalation rate is entered, for the model is designed to calculate IRR and NPV on 
nominal cash flows.  The user iterates by pressing the “Calculate ROE” button until the resulting 
Return on Equity is achieved to within 1% of the required ROE.   This ROE is equivalent to the 
computed IRR in the Discounted Cash Flow (DCF) analysis for the first N years, where N is the 
levelization basis for Revenue Requirements-based analysis.  

The iterative discounted cash flow analysis solves for the COE that meets the specified ROE 
over the levelization period while keeping the debt term cash flows unchanged.  For example, the 
debt may not be retired for thirty years, even if the levelization period is ten years.  As such, the 
debt service payments are treated the same as all other operating expense, and would be 
terminated if the asset were sold at the end of the levelization period. 

In order for the IRR on the “Overview” and “Results” sheets to be equivalent to the ROE on the 
“COE Calculation” sheet, the economic project life on line 53 of the “Scenario Inputs” sheet 
must equal the COE levelization basis on line 4 of the “COE Calculation” sheet. 

Important  If a #DIV/0 or #NUM Error is returned, the IRR/ROE is negative or undefined.  A 
higher COE must be entered. 

STEP 4 

Press the “Calculate Levelized COE” button.   The COE iterated in Step 2 is levelized over the 
specified levelization period, with a discount rate set to the After-tax Weighted Cost of Capital 
(ATWCC) ,where: 

ATWCC = (% Equity * ROE) + (% Debt * Weighted Cost of Debt * (1-Tax Rate)) 

STEP 5 

Finally, the Levelized COE is computed. 
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Levelized Cost of Electricity over P years =  

levelized annual 
capital charge + 

levelized annual 
fixed operating 

costs 
+

levelized annual 
variable operating 

costs LCOEP = 
annual net megawatt-hours 

of power generated 
 
 

(CCFP)(TPC)  + [(LFF1)(OCF1) + (LFF2)(OCF2) + …] + (CF)[(LFV1)(OCV1) + (LFV2)(OCV2) + …] LCOEP = (CF)(MWH) 
 
where: 
 
LCOE = levelized cost of electricity over P years, $/MWh (equivalent to mills/kWh) 
P =   levelization period (e.g., 10, 20 or 30 years) 
CCF =   capital charge factor for a levelization period of P years 
TPC = total plant cost [the sum of bare erected costs (includes costs of process 

equipment, supporting facilities, direct and indirect labor), detailed design costs, 
construction/project management costs, project contingency, process contingency 
and technology fees.], $ 

LFFn =   levelization factor for category n fixed operating cost 
OCFn =  category n fixed operating cost for the initial year of operation (but expressed in 

“first-year-of-construction” year dollars) 
CF =  plant capacity factor 
LFVn =  levelization factor for category n variable operating cost 
OCVn =  category n variable operating cost at 100% capacity factor for the initial year of 

operation (but expressed in “first-year-of-construction” year dollars) 
MWH =   annual net megawatt-hours of power generated at 100% capacity factor 
 

The CCF allows the analyst to use a simple equation to calculate a levelized COE instead of 
performing a full DCF analysis. When used in this way, all assumptions built into the DCF 
analysis also apply to the CCF that was derived from it, including the levelization period. 

Year Dollars  All costs should be expressed in “first-year-of-construction” year dollars, and the 
resulting LCOE is also expressed in “first-year-of-construction” year dollars.  For example, if the 
first year of plant construction was 2007, the TPC and operating costs should be entered in year 
2007 dollars and the resulting LCOE would be expressed in year 2007 dollars. 
 
Levelization Period  Capital charge factors and levelization factors are tabulated for levelization 
periods of ten, twenty and thirty years.  Although their useful life is usually well in excess of 
thirty years, a twenty-year levelization period is typically used for large energy conversion 
plants. 
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Many studies will report “tenth-year” COE, which are non-levelized values that reflect the 
nominal cost of electricity in the tenth year of operation.  These “tenth-year” COE values are 
typically very close to a twenty-year levelized cost of electricity (since the tenth year is the 
midpoint of the twenty-year levelization period). 
 

2.8 MULTIPLE PRODUCTS IN THE PSFM 
One of the major advantages of the PSFM is the ability to incorporate co-production of other 
plant outputs in addition to power.  Either co-products with positive value or waste products that 
subtract from the overall cash flow can be entered into the model.  The model contains input 
cells for flow-rates and values for the following co-products: 

  Steam,  

 Hydrogen,  

 Carbon Dioxide,  

 Sulfur,  

 Ash,  

 Fuels,  

 Chemicals, 

  Environmental credits  

 “Other”  

 

These entries were included because they are common co-products, but if desired, the model can 
be modified to include other items simply be renaming each of the entries for the relevant 
flowrate, escalation, and tariff values. 

In order to properly include co-products in a power system, the following steps should be taken: 

The “Primary Output” (Plant Inputs sheet, row 7) should be defined as “Multiple Outputs”.  The 
user then inputs the feedstock in terms of daily fuel consumption (lines 28 and 29) instead of 
heat rate.  While heat rate can be used, this is value has less meaning when co-products are 
produced, because their energy requirements are usually not included in the heat rate calculation.  
Entries then should be made for the flow-rate of the co-product, the tariff value, and the 
escalation rate.  Entering these items will assure that they are included in the cash flow 
calculations.  Note that the model typically does not allow negative values for tariffs; in order to 
include negative values, the user must go into the “Validation” section in the “Data” dropdown 
menu and allow negative values to be included. 

The PSFM model has been used and validated for a number of co-product cases, including 
steam, Fischer-Tropsch (FT) liquids, ammonia, and urea.  Examples of model inputs with co-
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products can be seen in the FT and hydrogen cases in the Appendix of the Nexant/DOE report 
“Gasification Plant Cost and Performance Optimization”, DE-AC26-99FT40342, September 
2003.
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Section 3 Key Definitions and Assumptions 

The following definitions and assumptions are included to provide the user with a more detailed 
explanation of the model’s inputs and parameters.  The same definitions can also be founding 
Appendix B, organized alphabetically. 

CAPITAL COSTS AND OPERATING EXPENSES 
Components of Total Plant Cost (TPC): 

Bare Erected Cost (BEC): BEC is the sum of all process equipment, supporting facilities, and 
direct and indirect labor.  BEC is the most fundamental cost estimate and is used as the basis for 
calculating engineering and home office fees.   

Engineering, Procurement, and Construction (EPC) Costs   The EPC cost category includes all 
relevant direct costs, indirect costs, and design services.  It can be defined as the BEC plus all 
detailed design, construction, and project management costs.  In the financial model, EPC costs 
should be entered as a lump sum amount (in thousand dollars), consistent with the model Base 
Year.  

 Direct cost elements include: process equipment, on-site facilities and infrastructure that 
support the plant, and the direct labor required for their installation and/or construction at 
the site.   

 Indirect cost elements cover all field costs (materials, subcontracts, manual and non-
manual labor), which cannot be specifically assigned to items in the direct cost category.  
The indirect field costs include temporary facilities, construction equipment, labor, field 
office costs, and consumable supplies. 

 Design costs include labor and material costs associated with the completion of project 
design services.   

EPC Cost Escalation Normally, the lump sum EPC cost should account for escalation over the 
construction period.    In the Scenario Inputs sheet, EPC costs are allocated across each year of 
construction (for 3-5 year periods.), and this allocation should reflect increases in costs. 

In Version 3 of financial model, an EPC Cost Escalation calculation sheet was added to 
explicitly escalate EPC costs and adjust the cost allocations, and a Yes/No option has been added 
to the Scenario Inputs sheets in order to employ EPC escalation.  See Appendix E for a detailed 
description. 

Owner’s (Project) Contingency   The owner’s or project contingency category covers all 
unforeseen costs that may impact the construction cost of a project.  Contingency funds are 
expected to be spent.  In the model, owner’s contingency costs are calculated as a percentage of 
total EPC costs.  Although contingency factors vary by project, a fifteen percent contingency 
factor is set as an initial default value based on the results of private power developer interviews.   
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Process Contingency Process contingency is designed to compensate for uncertainty in cost 
estimates caused by performance uncertainties associated with the development status of one or 
more plant sections.  Usually, this is not applied to the whole plant, but only to the 
technologically developing units such as gasification or hot gas cleanup.  The process 
contingency allowances (per the NETL Quality Guidelines) range from 0 to 40% of the plant 
section, with the value depending upon the technology status.   

Technology Fee   Technology fee costs include all licensing costs, pre-paid royalties, and know-
how fees.  Similar to owner’s contingency, the development fee is calculated as a percentage of 
total EPC costs.  Based on the results of market interviews, a four percent technology fee is used 
as a default value for calculating fee costs.      

Additional Components of Total Required Capital (TRC): 

Start-up Costs   Start-up costs include labor, materials, and consumable items directly linked to 
the start-up of a plant.  This includes all start-up capital cost items (including chemicals and 
catalysts).  For the purposes of analysis conducted using this model, the start-up cost of a project 
is calculated as a percentage of total EPC costs.  As an initial default value, start-up costs were 
set equal to two percent of total EPC costs.  

Owner’s cost  Owner’s cost includes separate costs that are directly incurred by the owner of a 
project.  Potential owner’s cost items include labor, land, project permitting, environmental 
reporting, and facilities.  In the financial model, owner’s cost items should be entered as a lump 
sum amount (in dollars thousand). 

Initial Working Capital An initial fund established and capitalized to fund expenses of ongoing 
operations. (Refer to the Initial Working Capital section below.) 

Initial Debt Reserve Fund A fund required by some financial institutions to secure debt payments. 
(Refer to the Debt Reserve Fund section below.) 

Additional Capital Cost A category for user defined capital costs 

Interest During Construction Interest charges accumulated during the construction period 

Financing Fees Additional fees associated with the debt portion of financing 

  

Ongoing Expenses    
Ongoing expenses included in the financial model are fuel (see engineering assumptions), 
Variable operation and maintenance (O&M), and Fixed O&M costs.  

Variable O&M.  Variable costs are dependent on the output level at a given plant.  Variable 
O&M costs include all consumable items, spare parts, and labor that fluctuate with the actual 
plant output. Variable costs are calculated as a percentage of total EPC costs, and are adjusted 
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according to the Guaranteed Availably factor specified in the Plant Inputs sheet. As an initial 
default value, variable O&M costs were assumed to equal 1.5% of total EPC costs.  Variable 
O&M costs can also be directly input, or calculated using key cost components. 

Fixed O&M.  Fixed costs include labor and other costs that are independent of the plant output 
level.  Fixed cost items must be paid whether or not the plant produces any output.  Fixed costs 
are calculated as a percentage of total EPC costs.  As an initial default value, fixed O&M was 
assumed to equal 3.5 %of total EPC costs. Fixed O&M costs can also be directly input, or 
calculated using key cost components. 

ECONOMIC AND FINANCIAL  
Tax Options The financial model contains the following options for calculating annual income 
taxes: 

 Standard tax rates can be used to calculate annual income taxes for a project under a 
regular tax schedule (i.e., during periods where there are no tax credits or benefits)   

 Subsidized tax rates can be used to evaluate the impact of potential tax credits on a 
project.  Subsidized tax rates can be employed for the entire life of a project or for a 
defined grace period (i.e., a set number of years that the subsidized rate is in effect).   

 Tax holidays can be used to evaluate projects that receive a tax holiday (i.e., no income 
taxes for a designated grace period).  Tax holidays are typically used to evaluate 
international projects.  

 Investment Tax Credit can be used to reduce the tax burden of the project in the startup 
year.  The project or corporation must have sufficient taxable income to take the full ITC 
in the startup year.  The ITC cannot be carried forward into future years. 

Project Loan Options   The financial model evaluates a wide range of financing options for 
projects, including the following:  

Multiple Sources of Debt   The financial model can assess projects using a maximum of three debt 
sources.  If multiples sources of debt are used, the user must specify one loan as senior and the 
others as subordinated debt.  Subordinated debt has a claim on the assets of a project in the event 
of bankruptcy only after senior debt has been paid.  

Debt Reserve Fund   The option to use a debt reserve fund is included for projects on which 
lenders require added debt service assurance. To use the Debt Reserve Fund option, the user 
should enter “Yes” in the designated input cell located in the Scenario Inputs sheet (in the 
Financial Assumptions section).  To exclude the Debt Reserve Fund option, the user should enter 
“No.”     

The debt reserve fund is available to pay debt service requirements in the event that the general 
funds available to the project are inadequate.  Based on interviews conducted with financial 
lending organizations, the debt reserve fund amount is estimated to be equal to fifty percent of 
total first year debt service.  The owner of a project using a debt reserve fund is entitled to 
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interest earnings on the fund.  An initial interest rate of five percent on the reserve fund is used as 
a default value.  For analysis conducted using this model, debt reserve funds can only be used for 
senior debt (i.e., Project Loan 1).   

Grace Period   Lenders often grant projects a grace period on the initial repayment of principal.  
Therefore, the model contains an option for using a grace period (in years) on the repayment of 
principal for each loan. 

Depreciation  
Construction costs can be depreciated using a straight-line method (variable number of years) or 
a 150% declining balance method over a period of 15 or 20 years.   Financing charges are can be 
separately depreciated using either method. 

Escalation of Operating Costs and Revenues 
The model escalates tariffs (the prices charged to end-users for project outputs such as 
electricity, steam, etc.), fuel costs, and operating expenses by an annual escalation rate.  

Forecast Fuel Costs 
The user has the option to use forecasted fuel prices rather than escalated prices.  The Fuel 
Forecasts sheet is used to enter forecasted fuel costs (for gas, coal, petroleum coke, and “other”) 
over a 35-year period.  There is a “Yes/No” option in the Scenario Inputs sheet to use forecasted 
or escalated fuel costs. 

Discount Rate 
All discount rates are assumed to be in nominal form. 

Initial Working Capital 1 and Working Capital Assumptions 
Initial working capital needs were assumed to be equal to 7% of first year’s sales as a default. 
Days payable and accounts receivable were both assumed to be 30 days. 

Working Capital is calculated in each year as the sum of accounts receivable, inventories, 
operating cash, less accounts payable.  It reflects the amount of capital that is tied up in 
receivables, money invested in inventories, and payables, plus cash on hand.   

The Operating Cash default in the model is set at $50,000, and maintained at that level, 
accounting for inflation.  The user should input an Operating Cash level appropriate to the 
project. 

Initial Working capital, at 7% of first year revenues, is the fund that is set up in the year prior to 
operations to initially fund the Working Capital account.  

                                                 
1 Working capital is included in this analysis because changes in working capital are relevant to the investment 
decision.  In addition to increases in fixed assets, investments require increases in working capital items, such as 
inventories and receivables. 
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The increase in working capital from year to year is subtracted from the operating cash flow to 
reflect how it is used in funding operations, and to maintain the fund at the desired level.  At the 
end of the project life, the Working Capital fund is returned to equity investors as a positive cash 
flow. 

Power Purchase Agreements (Initial Tariff Level) 
It is assumed that the power purchase agreement (or initial tariff) will be agreed upon prior to the 
construction start date.  Therefore, initial tariff levels should be entered in current (i.e., the first 
year of construction operations) dollars.  This Cost of Electricity (COE) input is also used with 
the COE Calculation sheet to calculate the equivalent COE for a given plant configuration and 
scenario input data. 

ENGINEERING AND CONSTRUCTION 
Note: Inputs for the project annual operating parameters (such as plant production, heat rate, 
operating hours, availability) are average values for the life of the project. 

Plant Heat Rate (Btu/kWh) 
This input is required for projects having electricity generation as the primary output. Plant heat 
rate is a measure of the amount of thermal energy needed to generate a given amount of electric 
energy. Plant heat rate is stated in Btu/kWh and is based on the higher heating value (HHV) of 
the relevant fuel.  The user has the option of specifying a primary and secondary fuel type. 

For multiple fuels, the heat rate of each fuel type is pro-rated by the percentage of time operating 
on each fuel.  The units of heat rate are then Btu of primary fuel/total kWh produced and Btu of 
secondary fuel/total kWh produced, so that the sum of the heat rates is a weighted average heat 
rate of the whole plant for an operating year. 

Annual Fuel Consumption: Power vs. Non-Power Applications  
Since integrated gasification combined cycle projects generate a wide range of outputs (e.g., 
electricity, hydrogen, steam, etc.), it is important to designate whether or not the generation of 
power is the primary application of a given IGCC plant.   The model requires this distinction to 
be made because for power applications, plant heat rate (stated in Btu/kWh) is used to calculate 
annual fuel costs.  If power generation is NOT the primary application of a plant, then plant heat 
rate is not relevant. When preparing input data for fuel consumption, the user should follow these 
steps: 

 If the primary application is electric power generation, the user should enter the “Power” 
option in the Primary Output/Plant Application line in the Plant Inputs Sheet.  The user 
should then enter a plant heat rate (in Btu/kWh) in Plant Inputs sheet for each fuel type. 

 If the primary application is NOT electric power generation, the user should enter the 
“Multiple Outputs” option in the Primary Output/Plant Application line in the Plant 
Inputs sheet.  The user should then enter daily fuel consumption level, assuming a 100% 
capacity factor, stated in either Mcf/day or Tons/day in the Plant Inputs sheet for each 
fuel type. 
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Overall Capacity Factor  
Overall  capacity factor is stated as the percentage of time a power plant is guaranteed to be 
available out of the total plant operating hours.  The capacity factor takes into account both 
planned and forced outages. 

This fraction is applied the total Variable O&M costs to calculate the actual O&M for the period 
for which the plant will actually be in service. 

Gross vs. Net Electric Power (MW)  
Gross capacity is the maximum capacity that a generating unit can sustain over time.  In the 
model, the user can enter both gross and net capacity.  Gross capacity is the plant maximum 
rated capacity, while net capacity is the plant output capacity reduced for plant self-consumption.  
For the purposes of analysis in the financial model, net capacity is used to generate key plant 
performance results (e.g., annual MWh, etc.)  

Construction Schedule (months) 
Construction schedule in the model is defined by the plant start-up year and length of 
construction period (in months). Using these parameters, the model calculates a start date. Plant 
production is assumed to start on January 1 of the start-up year.  

Plant Ramp-up Option 
To account for the plant start-up period, the model includes an option to allow the plant to 
gradually reach full capacity.  Specifically, the model calculates an average annual capacity 
percentage for up to the first two full years of operation.  Average annual capacity percentages 
are based on capacity inputs entered by the user for each quarter of the designated two years 
ramp-up period.  The plant capacity inputs entered by the user should reflect both planned and 
forced outages during the initial two-year start-up period.  These factors are independent of the 
Overall Capacity Factor used for following years of operation. 

To use the plant ramp-up option, the user should enter “Yes” in the designated input space 
located in the Scenario Inputs sheet (in the Construction Assumptions section).  To exclude the 
plant ramp-up option, the user should enter “No.”  
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Appendix A Plant Inputs and Scenario Inputs Sheets 

This section refers the user to specific lines in the Plant Inputs and Scenario Inputs worksheets 
noting important plant profile data and scenario data and scenario options, particularly those 
scenario options new in Versions 4 and 5 of the Power Systems Financial Model.  Line numbers 
from the worksheets note each item.  Also see Section 3 for additional descriptions of 
assumptions behind the data and options in the worksheets. 

PLANT INPUTS SHEET 
Line 7: Primary Output/Plant Application 
The user specifies “Power” or “Multiple Outputs” for the project.  If “Power”, then heat rate by 
fuel type is input in Lines 26-27; if “Multiple Outputs,” then fuel consumption by fuel type is 
input on Lines 28-29. 

Line 8-9: Primary and Secondary Fuel Type 
A primary fuel type (“Gas”, “Coal”, “Petroleum Coke”, “Other/Waste”) is entered in Line 8.  A 
secondary fuel can be entered in Line 9, or “None” if there is a single fuel. 

Note: the category “Other/Waste” can be used to represent three fuels in a plant profile.  For 
example, if the plant is to be run on coke and coal as a primary fuel and gas as a secondary fuel, 
the “Other/Waste” category could be used to represent coke and coal by using a weighted 
average (based on BTU content and percentage of each fuel used) for the heat rate, HHV, fuel 
consumption, and price. 

Line 11-22: Plant Outputs 
In the case of a plant with multiple outputs, the output quantities entered in these lines.  Units of 
tons are US Short Tons (2000 lbs.) 

Line 24: Overall Capacity Factor  

Overall  capacity factor is stated as the percentage of time a power plant is guaranteed to be 
available out of the total plant operating hours.  The capacity factor takes into account both 
planned and forced outages. 

Line 26-29: Heat Rate/Fuel Consumption 
Enter either the heat rate for the primary and secondary fuel, or the fuel consumption for the 
primary and secondary fuel.  If there is a single fuel type, leave the secondary fuel quantity blank 
or zero. 

Line 31: EPC Cost 
Enter the un-escalated EPC Cost (or implicitly escalated cost) or the Escalated EPC Cost (from 
the EPC Escalation sheet.)  See Section 3 for details.  The Base Year shown in the Scenario 
Inputs tab will be the basis for the DCF calculations; EPC entries should be considered relative 
to this Base Year. 
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Lines 32-40, and Lines 42-46: Other Development Costs, and Fixed and Variable 
Operating Costs 
These costs are calculated based on a percentage of the EPC cost and on a dollar basis.  
Remember that when escalated EPC costs are employed, the costs that are on a percentage basis 
of EPC are based on the escalated EPC.  A new parameter in Version 4.0 and 5.0 is the Process 
Contingency, and the percentage of the plant (% of EPC costs of plant units) that is 
technologically uncertain. 

In Version 4.0 and 5.0, the user has the option to directly enter or to calculate O&M costs, rather 
than specify O&M as a percentage of EPC.  Cells A45 and A47 provide this option. 

Line 48: Additional Comments 
Descriptions of the plant profile and scenario entered on this line are included in the top of each 
page printed out for the plant cases.  This feature is used to track various scenarios generated, so 
a sufficiently detailed description of the plant case and the scenario assumptions should be 
entered here. 

SCENARIO INPUTS SHEET 
Line 37-39: Debt Reserve Fund 
Indicate “Yes” or “No” to put the debt reserve fund into effect. 

Line 42-43: Depreciation 
“SL” for straight-line method, “DB” for 150% declining-balance method.  The straight-line 
method can use any depreciation life (that is reasonable and corresponds appropriately to the 
plant life); the declining balance method must use either a 15 or a 20-year period. 

Line 54 Discount Rate 

This discount rate is only used on the Results sheet to display the corresponding Net Present 
Value at that discount rate.  It is not used as a parameter in any other calculation. 

Line 57-78: Escalation Factors 
Input escalation factors for project outputs, fuels, and fixed and variable operating expenses.  
These inputs are typically in nominal terms. 

Line 79: EPC Cost Escalation 
The EPC cost escalation factor is used on the EPC Escalation worksheet to calculate the 
escalated EPC cost and re-calculate the construction cost allocation percentages.  See also Lines 
122-135. 
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Line 85-86: Investment Tax Credit 

The user inputs the ITC rate (default is 0%, but 10% is a reasonable assumption if the ITC is in 
place), and the maximum amount of the ITC that is available in the startup year, based upon 
sufficient taxable income for the project or owner.  ITC cannot be carried forward. 

Line 90-93: Fuel Prices 
Fuel prices are assumed to be for the base year over all scenarios (the earliest start date of 
construction over all plant profiles), and are escalated from this base price. 

Line 94: Forecast Fuel Price Option 
If “Yes” is input for the option “Use Forecasted Prices?” data from the sheet Fuel Forecasts is 
used in place of the user escalated fuel prices. 

Line 116: Base Year of Scenario 
The earliest construction start date from Line 118 is determined, and used as the base year for all 
plant scenarios. 

Line 121: EPC Cost Escalation  
If “Yes” is input for the option “EPC Cost Escalation in Effect?” then the user must use the EPC 
Escalation sheet to compute an escalated EPC cost and re-calculate the construction cost 
allocation percentages.  In this case, the percentages from Line 125 are used rather than those of 
Line 124, and the user must input the escalated EPC cost into Line 31 of the Plant Inputs sheet.  

Lines 124-135: Construction Cost Allocation over Construction Period 
See the description under Line 121. 

Line 136: Plant Ramp-up Option 
If “Yes” is input, the plant ramp-up option is put in effect. 

Lines 138-148: Start-up Operations Assumptions on Plant Capacity 

Average annual capacity percentages over the ramp-up period are based on capacity inputs 
entered by the user for each quarter of the designated two years ramp-up.  The plant capacity 
inputs entered by the user should reflect both planned and forced outages during the initial two-
year start-up period.  Important - these factors are independent of the Overall Capacity Factor 
used for following years of operation. 



 

 Power Systems Financial Model Version 5.0 Users’ Guide 26 

Appendix B Glossary 

Additional Capital Cost  

A category for user defined capital costs in the Plant Inputs sheet 

Annual Fuel Consumption: Power vs. Non-Power Applications  
Since integrated gasification combined cycle projects generate a wide range of outputs (e.g., 
electricity, hydrogen, steam, etc.), it is important to designate whether or not the generation of 
power is the primary application of a given IGCC plant.   The model requires this distinction to 
be made because for power applications, plant heat rate (stated in Btu/kWh) is used to calculate 
annual fuel costs.  If power generation is NOT the primary application of a plant, then plant heat 
rate is not relevant. When preparing input data for fuel consumption, the user should follow these 
steps: 

 If the primary application is electric power generation, the user should enter the “Power” 
option in the Primary Output/Plant Application line in the Plant Inputs Sheet.  The user 
should then enter a plant heat rate (in Btu/kWh) in Plant Inputs sheet for each fuel type. 

 If the primary application is NOT electric power generation, the user should enter the 
“Multiple Outputs” option in the Primary Output/Plant Application line in the Plant 
Inputs sheet.  The user should then enter daily fuel consumption level, assuming a 100% 
capacity factor, stated in either Mcf/day or Tons/day in the Plant Inputs sheet for each 
fuel type. 

Bare Erected Cost 

BEC is the sum of all process equipment, supporting facilities, and direct and indirect labor.  
BEC is the most fundamental cost estimate and is used as the basis for calculating engineering 
and home office fees.   

Base Year  

The earliest start year of construction for all scenarios considered in a single PSFM spreadsheet 
model.  This is the year used as the base year for discounting cash flows.  Base year is illustrated 
in Figure C-1.  

Capacity Factor (%) 
The capacity factor is the percentage of time a power plant is guaranteed to be available out of 
the total plant operating hours, including both planned and unplanned outages. 

This fraction is applied the total Variable O&M costs to calculate the actual O&M for the period 
for which the plant will actually be in service. 
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Plant life out to 30 years from start of operation

 

Figure B-1 Illustration of Base Year, Construction Period, and Plant Life 

Construction Schedule (months) 
Construction schedule in the model is defined by the plant start-up year and length of 
construction period (in months). Using these parameters, the model calculates a start date. Plant 
production is assumed to start on January 1 of the start-up year.  

Debt Reserve Fund  

The option to use a debt reserve fund is included for projects on which lenders require added 
debt service assurance. To use the Debt Reserve Fund option, the user should enter “Yes” in the 
designated input cell located in the Scenario Inputs sheet (in the Financial Assumptions section).  
To exclude the Debt Reserve Fund option, the user should enter “No.”     

The debt reserve fund is available to pay debt service requirements in the event that the general 
funds available to the project are inadequate.  Based on interviews conducted with financial 
lending organizations, the debt reserve fund amount is estimated to be equal to fifty percent of 
total first year debt service.  The owner of a project using a debt reserve fund is entitled to 
interest earnings on the fund.  An initial interest rate of five percent on the reserve fund is used as 
a default value.  For analysis conducted using this model, debt reserve funds can only be used for 
senior debt (i.e., Project Loan 1). 

Depreciation, Straight Line (“SL”) and Declining Balance (“DB”) 
Construction costs can be depreciated using a straight-line method (variable number of years) or 
a 150% declining balance method over a period of 15 or 20 years.   Financing charges are can be 
separately depreciated using either method. 

Discount Rate 
All discount rates are assumed to be in nominal (current) form. 
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Engineering, Procurement, and Construction (EPC) Costs   
EPC includes the BEC, plus detailed design and construction and project management.  EPC is 
the basis for calculating process and project contingencies, on a percentage basis of EPC. 

The EPC cost category includes all relevant direct costs, indirect costs, and design services.  In 
the financial model, EPC costs should be entered as a lump sum amount (in dollars thousand).  

 Direct cost elements include: process equipment, on-site facilities and infrastructure that 
support the plant, and the direct labor required for their installation and/or construction at 
the site.   

 Indirect cost elements cover all field costs (materials, subcontracts, manual and non-
manual labor), which cannot be specifically assigned to items in the direct cost category.  
The indirect field costs include temporary facilities, construction equipment, labor, field 
office costs, and consumable supplies. 

 Design costs include labor and material costs associated with the completion of project 
design services.   

EPC Cost Escalation  

Normally, the lump sum EPC cost should account for escalation over the construction period.    
In the Scenario Inputs sheet, EPC costs are allocated across each year of construction (for 3-5 
year periods.), and this allocation should reflect increases in costs. 

In Version 3 of financial model, an EPC Cost Escalation calculation sheet was added to 
explicitly escalate EPC costs and adjust the cost allocations, and a Yes/No option has been added 
to the Scenario Inputs sheets in order to employ EPC escalation.  See Appendix E for a detailed 
description.  

Escalation of Operating Costs and Revenues 
The model escalates tariffs (the prices charged to end-users for project outputs such as 
electricity, steam, etc.), fuel costs, and operating expenses by an annual escalation rate.   The 
escalation rate should include both the effects of monetary inflation and price escalation when 
dollars are expressed on a Current or Nominal basis. 

Financing Fees  

Additional fees associated with the debt portion of financing 

Fixed O&M   

Fixed costs include labor and other costs that are independent of the plant output level.  Fixed 
cost items must be paid whether or not the plant produces any output.  Fixed costs are calculated 
as a percentage of total EPC costs.  As an initial default value, fixed O&M was assumed to equal 
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3.5 percent of total EPC costs. Fixed O&M costs can also be directly input, or calculated using 
key cost components.  Fixed costs should include fixed labor (administrative and management), 
property tax and insurance, and fixed maintenance. 

Forecast Fuel Costs 
The user has the option to use forecasted fuel prices rather than escalated prices.  The Fuel 
Forecasts sheet is used to enter forecasted fuel costs (for gas, coal, petroleum coke, and “other”) 
over a 35-year period.  There is a “Yes/No” option in the Scenario Inputs sheet to use forecasted 
or escalated fuel costs.  Fuel costs should be input on a nominal or current basis, which includes 
the effects of both inflation and price escalation or de-escalation. 

Gross vs. Net Electric Power (MW)  
Gross capacity is the maximum capacity that a generating unit can sustain over time.  In the 
model, the user can enter both gross and net capacity.  Gross capacity is the plant maximum 
rated capacity, while net capacity is the plant output capacity reduced for plant self-consumption.  
For the purposes of analysis in the financial model, net capacity is used to generate key plant 
performance results (e.g., annual MWh, etc.)  

Initial Working Capital 2 and Working Capital Assumptions 
An initial fund established and capitalized to fund expenses of ongoing operations. Initial 
working capital needs were assumed to be equal to 7% of first year’s sales as a default. Days 
payable and accounts receivable were both assumed to be 30 days. 

Working Capital is calculated in each year as the sum of accounts receivable, inventories, 
operating cash, less accounts payable.  It reflects the amount of capital that is tied up in 
receivables, money invested in inventories, and payables, plus cash on hand.   

Interest During Construction  

Interest charges accumulated during the construction period. 

Loan Options    
The financial model evaluates a wide range of financing options for projects, including the 
following:  

 Multiple Sources of Debt   The financial model can assess projects using a maximum of 
three debt sources.  If multiples sources of debt are used, the user must specify one loan 
as senior and the others as subordinated debt.  Subordinated debt has a claim on the assets 
of a project in the event of bankruptcy only after senior debt has been paid.  

                                                 
2 Working capital is included in this analysis because changes in working capital are relevant to the investment 
decision.  In addition to increases in fixed assets, investments require increases in working capital items, such as 
inventories and receivables. 



    

 Power Systems Financial Model Version 5.0 Users’ Guide 30 

 Grace Period   Lenders often grant projects a grace period on the initial repayment of 
principal.  Therefore, the model contains an option for using a grace period (in years) on 
the repayment of principal for each loan. 

 

Owner’s (Project) Contingency   

The owner’s or project contingency category covers all unforeseen costs that may impact the 
construction cost of a project.  Contingency funds are expected to be spent.  In the model, 
owner’s contingency costs are calculated as a percentage of total EPC costs.  Although 
contingency factors vary by project, a nine percent contingency factor is set as an initial default 
value based on the results of private power developer interviews.  

Owner’s Cost   

Owner’s cost includes separate costs that are directly incurred by the owner of a project.  
Potential owner’s cost items include labor, land, project permitting, environmental reporting, 
legal, and facilities.  In the financial model, owner’s cost items should be entered as a lump sum 
amount (in dollars thousand). 

Plant Heat Rate (Btu/kWh)  
Note: Inputs for the project annual operating parameters (such as plant production, heat rate, 
operating hours, availability) are average values for the life of the project. 

This input is required for projects having electricity generation as the primary output. Plant heat 
rate is a measure of the amount of thermal energy needed to generate a given amount of electric 
energy. Plant heat rate is stated in Btu/kWh and is based on the higher heating value (HHV) of 
the relevant fuel.  The user has the option of specifying a primary and secondary fuel type. 

For multiple fuels, the heat rate of each fuel type is pro-rated by the percentage of time operating 
on each fuel.  The units of heat rate are then Btu of primary fuel/total kWh produced and Btu of 
secondary fuel/total kWh produced, so that the sum of the heat rates is a weighted average heat 
rate of the whole plant for an operating year. 

Plant Operating Hours 
Annual operating hours for each plant is the input to account for plant planned outages 
(maintenance period). Plant operating hours are calculated as:  

Operating Hours = 8,760 Hours – Planned Outage Hours 

Plant Ramp-up Option 
To account for the plant start-up period, the model includes an option to allow the plant to 
gradually reach full capacity.  Specifically, the model calculates an average annual capacity 
percentage for up to the first two full years of operation.  Average annual capacity percentages 
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are based on capacity inputs entered by the user for each quarter of the designated two years 
ramp-up period.  The plant capacity inputs entered by the user should reflect both planned and 
forced outages during the initial two-year start-up period.  These factors are independent of 
capacity factors used for following years of operation. 

To use the plant ramp-up option, the user should enter “Yes” in the designated input space 
located in the Scenario Inputs sheet (in the Construction Assumptions section).  To exclude the 
plant ramp-up option, the user should enter “No.”  

Power Purchase Agreements (Initial Tariff Level) 
It is assumed that the power purchase agreement (or initial tariff) will be agreed upon prior to the 
construction start date.  Therefore, initial tariff levels should be entered in current (i.e., the first 
year of construction operations) dollars.  This Cost of Electricity (COE) input is also used with 
the COE Calculation sheet to calculate the equivalent COE for a given plant configuration and 
scenario input data. 

Process Contingency  

Process contingency is designed to compensate for uncertainty in cost estimates caused by 
performance uncertainties associated with the development status of one or more plant sections.  
Usually, this is not applied to the whole plant, but only to the technologically developing units 
such as gasification or hot gas cleanup.  The process contingency allowance depends upon the 
technology status of the unit.   

Start-up Costs    

Start-up costs include labor, materials, and consumable items directly linked to the start-up of a 
plant.  This includes all start-up capital cost items (including chemicals and catalysts).  For the 
purposes of analysis conducted using this model, the start-up cost of a project is calculated as a 
percentage of total EPC costs.  As an initial default value, start-up costs were set equal to two 
percent of total EPC costs.  

Startup costs are in addition to the initial and ongoing working capital, if they are used in the 
analysis. 

Tax Options  
The financial model contains the following options for calculating annual income taxes: 

 Standard tax rates can be used to calculate annual income taxes for a project under a 
regular tax schedule (i.e., during periods where there are no tax credits or benefits)   

 Subsidized tax rates can be used to evaluate the impact of potential tax credits on a 
project.  Subsidized tax rates can be employed for the entire life of a project or for a 
defined grace period (i.e., a set number of years that the subsidized rate is in effect).   
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 Tax holidays can be used to evaluate projects that receive a tax holiday (i.e., no income 
taxes for a designated grace period).  Tax holidays are typically used to evaluate 
international projects.  

 Investment Tax Credit can be used to reduce the tax burden of the project in the startup 
year.  The project or corporation must have sufficient taxable income to take the full ITC 
in the startup year.  The ITC cannot be carried forward into future years. 

Property taxes should be included in the Fixed O&M costs. 

Technology Fee    

Technology fee costs include all licensing costs, pre-paid royalties, and know-how fees.  Similar 
to owner’s contingency, the development fee is calculated as a percentage of total EPC costs.  
Based on the results of market interviews, a four percent technology fee is used as a default value 
for calculating fee costs.      

Total Plant Cost 

TPC includes EPC cost plus process and project contingencies, and technologies fees. 

Total Required Capital 

TRC is includes the TPC, plus startup costs, owners costs, financing costs, and the time value of 
money over the construction period, calculated as the Interest During Construction (IDC). 

Variable O&M   

Variable costs are dependent on the output level at a given plant.  Variable O&M costs include 
all consumable items, spare parts, and labor that fluctuate with the actual plant output. Variable 
costs are calculated as a percentage of total EPC costs, and are adjusted according to the 
Guaranteed Availably factor specified in the Plant Inputs sheet. As an initial default value, 
variable O&M costs were assumed to equal 0.6% of total EPC costs.  Variable O&M costs can 
also be directly input, or calculated using key cost components. 

The Operating Cash default in the model is set at $50,000, and maintained at that level, 
accounting for inflation.  The user should input an Operating Cash level appropriate to the 
project. 

Initial Working capital, at 7% of first year revenues, is the fund that is set up in the year prior to 
operations to initially fund the Working Capital account.  

The increase in working capital from year to year is subtracted from the operating cash flow to 
reflect how it is used in funding operations, and to maintain the fund at the desired level.  At the 
end of the project life, the Working Capital fund is returned to equity investors as a positive cash 
flow. 
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Appendix C System Requirements 

To operate the financial model, the user must have a computer equipped with 32 MB or more of 
RAM, and must be running Microsoft Excel 2000 or Excel 2003 with the ‘Analysis ToolPak’ 
add-in installed.  To install the Analysis ToolPak, go to Tools ⇒ Add-Ins, and select the 
Analysis ToolPak.  Then select OK. 

Important: The Power Systems Financial Model is not backwardly compatible with previous 
versions of Excel. 

START-UP AND SHUT-DOWN OF THE FINANCIAL MODEL 
After the PAF Model has been successfully installed on your computer, the model can be opened 
and closed as a regular Microsoft Excel 2000 or 2003 file.  Some general instructions on opening 
and closing the financial model are provided below.     

Opening the Model 
Open Microsoft Excel 200(3) 
Select File ⇒ Open   
Navigate to where you saved “NETL Power Systems Financial Model Version 5.0.xls” during 
the installation process 
Double-click on the “NETL Power Systems Financial Model Version 5.0.xls” file or select it and 
click on open 
 
Closing the Model 

1. Select File ⇒ Close 
2. Select either Yes or No when asked whether or not you want to save changes.  Do not select 

Cancel.  Selecting Cancel could cause you to remove the Directory and Print Option menus.  
If you do select Cancel, close the model (saved or unsaved) and then reopen the file. 

3. As the user creates more scenarios, he/she may want to establish a subdirectory of folders to 
better manage and maintain different files.  In this manner, past scenarios can be easily 
referenced and used for further analysis.  



 

 Power Systems Financial Model Version 5.0 Users’ Guide 34 

Appendix D Version History 

Version 3.0: Release of upgraded model. 

Version 3.01: Corrected the calculation of plant efficiency for the case of multiple fuels, cell 
B37 in the Plant Performance worksheet.  This error did not affect model results, but was a point 
of confusion for users.   

The users manual was updated to clarify data input for the case of multiple fuels. 

Version 4.0 Updated Project Contingency default, added Project Contingency, added Investment 
Tax Credit Option, added option to input detailed O&M costs. 

Version 5.0 Model name changed to Power Systems Financial Model (from IGCC Financial 
Model.)  Added Cost of Electricity (COE) and Capital Charge Factor (CCF) calculations. 
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Appendix E                                                      Upgrades in Versions 5, 4 and 3 

MODEL UPGRADES IN VERSION 5  
The model name changed to the Power Systems Financial Model (from IGCC Financial Model), 
reflecting its applicability to a range of power systems.   Cost of Electricity (COE) and Capital 
Charge Factor (CCF) calculations were added to the model.   

Cell titles in the model were changed to improve the clarity of field descriptions. 

An “About the PSFM” drop-down dialog box was added to the Directory menu.  The box 
contains the version number and date. 

MODEL UPGRADES IN VERSION 4 
Project (Owners) Contingency 
The default value for the Owners, or Project, Contingency has been revised to 15%.  A 
reasonable range would be from 15% to 40%, depending on the degree to which engineering, 
design and costing has been performed.  Higher project contingency rates should be used for 
projects that have not been designed and costed in great detail.   

Reminder Users should validate all default data for their specific projects 

Process Contingency 
Process contingency was a new parameter in Version 4.0 of the IGCC Financial Model.  Process 
contingency is designed to compensate for uncertainty in cost estimates caused by performance 
uncertainties associated with the technology development status of one or more plant sections.  
Process contingency is only applied to technologically developing units such as gasification or 
hot gas cleanup.    

A fraction of the plant cost that is technologically uncertain is specified in the Plant Inputs sheet 
for the project.  The process contingency is then applied to this EPC fraction.  

 The default value for process contingency is 20% of EPC costs. 

For example, if 10% of the plant is technologically uncertain, and a 40% process contingency is 
applied, 4% of the EPC costs are allocated to the process contingency. 

Investment Tax Credit 
The investment tax credit (ITC) rate is applied to the EPC cost in the first year of operation.  This 
tax credit is then subtracted from total taxes in the first year operation. 

In the Scenario Inputs sheet, under Tax Assumptions, an ITC rate, and a maximum available ITC 
available in the startup year, are specified.  The default ITC rate is 10%, and the default 
maximum available ITC is set to a large number (e.g. on the order of the EPC cost.)  A lower 
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available ITC is input if the project there is not enough taxable income to claim the full ITC.  
The ITC must be fully claimed in startup year; it cannot be carried over into future years. 

Operation and Maintenance (O&M) Costs 
There are three means for specifying O&M costs: 1) by entering a percentage of EPC costs for 
fixed and variable O&M; 2) by directly entering fixed and variable costs, or 3) by using a 
calculation spreadsheet that has the user input the major components of fixed and variable O&M 
costs, such as number of operators, wages and benefits, insurance, and consumables. 

Default values for O&M percentages of EPC costs have been included.  The Fixed O&M is set to 
a default of 5%.  (Remember, users should independently validate all default data.)  Variable 
O&M is set to a default of 0.6%. 

On the Plant Inputs sheet, the user has the option to choose to directly input or to calculate O&M 
costs, as opposed to using a percentage of EPC costs.  Cells A45 and A47 provide “Yes/No” 
choices to this affect. 

If the user opts to directly enter or calculate costs, the O&M sheet is used for input.  On this 
sheet, the user chooses to “Enter” or “Calculate” O&M costs.  If “Enter” is chosen, the O&M 
costs are simply entered in the appropriate cells.  If “Calculate”, then the O&M calculator in the 
lower portion of the sheet is used. 

No default values for the directly entered O&M costs are provided on the O&M sheet. – These 
are project specific costs that cannot be generically entered as defaults. 

MODEL UPGRADES IN VERSION 3 
Measurement Units  
All units in the model have been changed to US/British units.    Previously, fuel inputs and plant 
outputs were measured in Metric Tons (except for natural gas, which is measured in Million 
Cubic Feet).  Units are now US Shorts Tons (2000 lbs.).  HHV for fuels are now input as 
BTU/lb. 

Variable Base Year for Scenarios 
The base year for the scenario is now a variable input.  The earliest year over all plant 
construction start dates is determined, and this becomes the base year for all plant scenarios.   

Construction Period 
The construction period can be set to 3, 4 or 5 years.  

Construction for all scenarios must start and end within the first ten years of the start of 
construction of the first project.   The bar chart on the Results worksheet has been updated to 
show construction costs over 3 to 5 years that occur within the first ten years.  (Note: See the 
section on EPC Escalation.  The EPC costs are assumed to be relative to the construction start 
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date; that is, they are in the construction start-date year’s dollars.   If the EPC cost escalation 
option is chosen, costs are escalated relative to the construction start date.) 

In order to accommodate a 3, 4, or 5-year construction period, three tables have been created on 
the Scenario Inputs sheet that contain data for the allocation of EPC costs over 3, 4 or 5 year 
construction periods.  Each plant profile is based upon the appropriate table.  As in earlier 
versions of the model, all scenarios having the same construction period length will use the same 
EPC cost allocations.    

If a construction period length is between 3 and 4 years, then the 4-year allocation is applied.  If 
it is between 4 and 5 years, the 5-year allocation is applied.  Of course, if the length is exactly 3, 
4 or 5 years, then the 3, 4, or 5-year allocations, respectively, are used. 

Error checking is performed on the input for each line item in the allocation tables.  If any of the 
totaled percentages in the tables is less than 100%, for any line item (e.g. EPC costs) an error is 
generated. 

Escalation of EPC Costs 
In previous versions of the model, the assumption was made that cost escalation was factored 
into the total EPC figure.  This is still the (highly) recommended method, since escalation of 
EPC costs will not significantly affect the IRR for any project, and it considerably simplifies the 
analysis. 

However, an option has been added to explicitly escalate EPC costs in Version 3 of the model.   
The EPC Escalation sheet is used to enter the un-escalated total EPC cost, the construction 
period in years, and the EPC escalation factor (which is read from the Scenario Inputs sheet.)  
The user must also have input a set of initial yearly cost allocations on the Scenario Inputs page 
corresponding to the un-escalated EPC for the appropriate construction period. 

The EPC Escalation sheet calculates an escalated EPC and a set of cost allocation percentages. 
The allocations must be automatically copied back to the Scenario Inputs sheets.  The allocation 
percentages must be calculated for each construction time period (3, 4 and 5 years) and must be 
recalculated when the escalation factor is changed.    

The user must manually re-input the resulting total escalated EPC cost into the Plant Inputs sheet 
for the appropriate plant profile.   

On the Scenario Inputs sheet, there are two EPC percentage-by-year allocation lines; one for 
escalated EPC (used to copy the escalated results, which are in red) and one for un-escalated 
EPC (use for the initial allocations, which are in blue.)   The user chooses which case to use with 
a yes/no option on the Scenario Inputs sheet. 

Here is a step-by-step guide to using the EPC Escalation Calculator: 

Step 1:  In the Scenario Inputs sheet:   
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 Set Cell B121 in Scenario Inputs to “Yes” 

 Input the EPC escalation rate in Cell B79 

Input the initial yearly cost allocations for EPC in Cells B124-M124.   

Important – do not rely on the default data – make sure to input/validate your own data. 

Step 2: In the EPC Escalation sheet: 

Input the un-escalated total EPC cost in Cell B2.   

Important – this should be in years-dollars corresponding to the start date of 
construction.  

 Input the number years of construction. 

Press the “Copy” button to copy the escalated-yearly-allocation percentages into the 
Scenario Inputs sheet. 

Manually enter the escalated EPC cost from Cell B6 into the appropriate cell in Line 31 
of the Plant Inputs sheet. 

Important If the EPC escalation rate is changed, this procedure must be repeated. 

Multiple Fuels 
Version 3 of the model allows the user to specify a primary and a secondary fuel type.  The user 
must specific a primary fuel, and has the option of choosing a secondary fuel or specifying 
“None” in the Plant Inputs sheet. 

For power projects, the user inputs the heat rate for each fuel type, in Btu/kWh.      

For non-power projects, the user inputs the fuel consumption rate by fuel type.   

This allows the user to run scenarios that employ gas and coal or coke together.  If the user wants 
to run three fuels (e.g. coal, coke, and gas), then the “Other/Waste” fuel option is used as one 
fuel for coal and coke with an HHV and fuel cost weighted –average according to the fuel 
mixture used.  

For the heat rate of each fuel type, the user pro-rates the total heat rate by the percentage of time 
operating on each fuel.  The units of heat rate are then Btu of primary fuel/total kWh produced 
and Btu of secondary fuel/total kWh produced, so that the sum of the heat rates is a weighted 
average heat rate of the whole plant for an operating year. 
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Depreciation 
A 150% declining-balance over 15 or 20 years has been added as an option for depreciation.    In 
the Scenario Inputs sheet, a “Method” option for depreciation has been added.  The user inputs 
either “SL” or “DB” and specifies the depreciation period.  Error checking is performed on the 
user input. 

Plant Life of 20 to 30 years 
Plant life has been extended to a maximum of 30 years. A plant life of between 20 and 30 years 
is permitted.    However, since construction can start any time within the first 10 years, the user 
must ensure that the construction start date plus the construction period plus the plant life does 
not exceed 35 years (the maximum number of periods.) 

Printouts 
Model printouts now contain a descriptive comment that is supplied by the user. This text is 
entered into the “Additional Comments” field on the Plant Input sheet (Line 48) for each plant 
profile. 

Fuel Cost Forecast Data Option 
An input sheet called Fuel Forecasts has been added.  The user can input prices for each fuel 
type over a 35-year period.   In the Scenario Inputs sheet, a “yes/no” option has been added to 
use the forecast data or the escalated fuel prices.    

 


